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Reference to the whole or to part of this volume should be made as follows: 

Print citation for Chapter 1:
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Proc. ODP, Init. Repts., 199: College Station TX (Ocean Drilling Program), 1–87.

CD-ROM volume citation:
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Init. Repts., 199, 1–59 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M University, 
College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
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Volume 197 (Initial Reports): August 2002
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Volume 172 (Scientific Results): September 2001
Volume 175 (Scientific Results): March 2002
Volume 180 (Scientific Results): September 2002

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.
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Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications


5

PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 

Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 

accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication formats.

Some close-up photographs of very dark cores have been tonally enhanced to better illustrate 
particular features of interest.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph is of middle Eocene radiolarians from ODP Site 1217, Leg 199. Radiolarian oozes 
are the characteristic sediment of the Eocene in the eastern equatorial Pacific. Image taken by Isabella 
Raffi.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.
The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 18 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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CD-ROM CONTENTS: CORE DESCRIPTIONS

Visual core descriptions (VCDs) and smear slide data tables are included in this section. ASCII versions 
of the smear slide data tables are also available (see “ASCII Tables”). 

Site 1215

Visual Core Descriptions · Smear Slides 

Site 1216

Visual Core Descriptions · Smear Slides 

Site 1217

Visual Core Descriptions · Smear Slides 

Site 1218

Visual Core Descriptions · Smear Slides 

Site 1219
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of selected biostratigraphy, paleomagnetism, geochemistry, and 
physical properties tables from the text and all of the smear slide data tables presented under “Core 
Descriptions.” A complete listing of the ASCII tables can be found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 

ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program but not directly 
from PDF files.

Chapter 1 Chapter 10  Chapter 14 

Chapter 2 Chapter 11  Chapter 15 

Chapter 8 Chapter 12  Smear slide data tables 

Chapter 9 Chapter 13  
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Chapter 1, Leg 199 Summary
Table T1. Hole summary, Leg 199.

Chapter 2, Explanatory Notes
Table T2. Age estimates of planktonic foraminifer datum events.
Table T3. Age estimates of radiolarian datum events.
Table T4. Ages used for the geomagnetic polarity timescale (normal polarity interval).

Chapter 8, Site 1215
Table T2. Calcareous nannofossil datums, Site 1215.
Table T5. Composite depths, Site 1215.
Table T6. Core disturbance, Site 1215.
Table T7. Splice tie point table, Site 1215.
Table T8. Paleomagnetic events, Site 1215.
Table T9. Nannofossil and foraminifer events, Site 1215.
Table T10. Linear sedimentation rates (LSRs), dry bulk density (DBD), and mass accumulation rates 

(MARs) for major lithologic units, Site 1215.

Table T11. Interstitial water data, Site 1215.
Table T12. Bulk sediment data, Hole 1215A.
Table T13. Calcium carbonate and organic carbon data, Hole 1215A.
Table T14. Moisture and density measurements, Site 1215.
Table T15. LAS mineralogy determinations, Site 1215.
Table T16. Split-core velocity measurements, Hole 1215A.
Table T17. Thermal conductivity, Site 1215.

Chapter 9, Site 1216
Table T4. Core disturbance, Site 1216.
Table T5. Paleomagnetic events, Site 1216.
Table T6. Radiolarian events, Site 1216.
Table T7. Linear sedimentation rates (LSRs), dry bulk density (DBD), and mass accumulation rates 
(MARs) for major lithologic units, Hole 1216A.
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Table T8. Interstitial water data, Hole 1216A.
Table T9. Bulk sediment data, Site 1216.
Table T10. Calcium carbonate (CaCO3) and organic carbon data, Hole 1216A.
Table T11. Moisture and density measurements, Site 1216.
Table T12. LAS-based mineralogy, Hole 1216A.
Table T13. Split-core velocity measurements, Site 1216.
Table T14. Thermal conductivity, Site 1216.

Chapter 10, Site 1217
Table T3. Composite depths of identified geomagnetic reversals, Site 1217.
Table T4. Core disturbance, Site 1217.
Table T5. Composite depths, Site 1217.
Table T6. Splice tie points, Site 1217.
Table T7. Paleomagnetic events used for LSR calculations, Site 1217.
Table T8. Nannofossil and radiolarian events used for LSR calculations, Site 1217.

Table T9. Linear sedimentation rates (LSRs), dry bulk density (DBD), and mass accumulation rates 
(MARs) for major lithologic units, Site 1217.

Table T10. Interstitial water data, Hole 1217A.
Table T11. Bulk sediment data, Holes 1217A and 1217B.
Table T12. Calcium carbonate and organic carbon data, Holes 1217A and 1217B.
Table T13. Moisture and density measurements, Holes 1217A and 1217B.
Table T14. LAS-based mineralogy, Hole 1217A.
Table T15. Split-core velocity measurements, Holes 1217A and 1217B.
Table T16. Thermal conductivity, Hole 1217A.

Chapter 11, Site 1218
Table T3. Calcareous nannofossil datums, Site 1218.
Table T6. Planktonic foraminifer datum levels, Site 1218.
Table T8. Distribution of radiolarian datum levels, Site 1218.
Table T9. Composite depth of identified geomagnetic reversals, Site 1218.
Table T10. Core disturbance, Site 1218.
Table T11. Composite depths, Site 1218.
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Table T12. Splice tie points, Site 1218.
Table T13. Paleomagnetic events, Site 1218.
Table T14. Nannofossil, foraminifer, and radiolarian events, Site 1218.
Table T15. Depths, ages, rates, and fluxes of sediments, Hole 1218A.
Table T16. Interstitial water data, Hole 1218A.
Table T17. Bulk sediment data, Hole 1218A.
Table T18. CaCO3 and Corg data, Site 1218.
Table T19. Moisture and density measurements, Hole 1218A.
Table T20. LAS-based mineralogy, Hole 1218A.
Table T21. Split-core velocity measurements, Hole 1218A.
Table T22. Thermal conductivity, Holes 1218A and 1218B.
Table T23. In situ temperature, Holes 1218B and 1218C.

Chapter 12, Site 1219
Table T2. Calcareous nannofossil datums, Site 1219.

Table T5. Planktonic foraminifer datum levels, Hole 1219A.
Table T7. Distribution of radiolarian datum levels, Site 1219.
Table T8. Core disturbance, Site 1219.
Table T9. Composite depths, Site 1219.
Table T10. Splice tie points, Site 1219.
Table T11. Paleomagnetic events, Site 1219.
Table T12. Nannofossil, foraminifer, and radiolarian events, Site 1219.
Table T13. Depths, ages, rates, and fluxes of sediments, Hole 1219A.
Table T14. Interstitial water data, Hole 1219A.
Table T15. Bulk sediment data, Hole 1219A.
Table T16. Calcium carbonate and organic carbon data, Hole 1219A.
Table T17. Moisture and density measurements, Hole 1219A.
Table T18. LAS-based mineralogy, Hole 1219A.
Table T19. Split-core velocity measurements, Hole 1219A.
Table T20. Thermal conductivity, Site 1219.
Table T21. In situ temperature, Hole 1219B.
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Chapter 13, Site 1220
Table T2. Calcareous nannofossil datums, Holes 1220A and 1220B.
Table T5. Radiolarian first and last occurrences and zonal boundaries, Site 1220.
Table T6. Composite depths of identified geomagnetic reversals, Site 1220.
Table T7. Core disturbance, Site 1220.
Table T8. Composite depths, Site 1220.
Table T9. Splice tie points, Site 1220.
Table T10. Paleomagnetic events, Site 1220.
Table T11. Nannofossil, foraminifer, and radiolarian events, Site 1220.
Table T12. Depths, ages, rates, and fluxes of sediment, Site 1220.
Table T13. Interstitial water data, Holes 1220A and 1220B.
Table T14. Bulk sediment data, Holes 1220A and 1220B.
Table T15. CaCO3 and Corg data, Holes 1220A and 1220B.
Table T16. Moisture and density measurements, Hole 1220A.
Table T17. LAS-based mineralogy, Holes 1220A and 1220B.

Table T18. Split-core velocity measurements, Holes 1220A and 1220B.
Table T19. Thermal conductivity, Holes 1220A and 1220B.
Table T20. In situ temperature, Hole 1220B.

Chapter 14, Site 1221
Table T2. Calcareous nannofossil datums, Site 1221.
Table T3. Radiolarian zonal boundaries, Site 1221.
Table T4. Core disturbance, Holes 1221A, 1221B, and 1221C.
Table T5. Composite depths, Site 1221.
Table T6. Splice tie points, Holes 1221A, 1221B, and 1221C.
Table T7. Paleomagnetic events, Site 1221.
Table T8. Nannofossil, foraminifer, and radiolarian events, Site 1221.
Table T9. Depths, ages, rates, and fluxes of sediments, Site 1221.
Table T10. Interstitial water data, Hole 1221A.
Table T11. Bulk sediment data, Holes 1221A, 1221B, and 1221C.
Table T12. CaCO3 and Corg, Holes 1221A, 1221B, and 1221C.
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Table T13. MAD measurements, Holes 1221A, 1221B, and 1221C.
Table T14. LAS-based mineralogy, Holes 1221A and 1221B.
Table T15. Split-core velocity measurements, Holes 1221A, 1221B, and 1221C.
Table T16. Thermal conductivity, Holes 1221A and 1221B.

Chapter 15, Site 1222
Table T3. Radiolarian zonal boundaries, Site 1222.
Table T4. Core disturbance, Site 1222.
Table T5. Composite depths, Site 1222.
Table T6. Splice tie points, Site 1222.
Table T7. Paleomagnetic events, Site 1222.
Table T8. Nannofossil and radiolarian events, Site 1222.

Table T9. Depths, ages, rates, and fluxes of sediments, Site 1222.
Table T10. Interstitial water data, Hole 1222A.
Table T11. CaCO3 and Corg data, Hole 1222A.
Table T12. Moisture and density measurements, Hole 1222A.
Table T13. LAS-based mineralogy, Hole 1222A.
Table T14. Split-core velocity measurements, Hole 1222A.
Table T15. Thermal conductivity, Site 1222.

Smear Slide Data Tables
Site 1215 smear slide table.
Site 1216 smear slide table.
Site 1217 smear slide table.
Site 1218 smear slide table.
Site 1219 smear slide table.
Site 1220 smear slide table.
Site 1221 smear slide table.
Site 1222 smear slide table.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
The Initial Reports CD-ROM contains supplementary data files presented as ASCII files and Microsoft 
Excel 97/98 spreadsheets. The files present expanded coring summary tables and information on the 
gamma ray attenuation, light absorption spectroscopy, natural gamma ray, P-wave logging, light 
reflectance, and magnetic susceptibility data. Supplementary material files are located in the 
SUPP_MAT directory.

CRSM
1215CRSM.TXT
1216CRSM.TXT
1217CRSM.TXT
1218CRSM.TXT

GRA_1218
GRA1218A.XLS
GRA1218B.XLS
GRA1218C.XLS

GRA_1219

1219CRSM.TXT
1220CRSM.TXT
1221CRSM.TXT
1222CRSM.TXT

GRA

GRA_1215
GRA1215A.XLS
GRA1215B.XLS

GRA_1216
GRA1216A.XLS
GRA1216B.XLS

GRA_1217
GRA1217A.XLS
GRA1217B.XLS
GRA1217C.XLS

GRA1219A.XLS
GRA1219B.XLS

GRA_1220
GRA1220A.XLS
GRA1220B.XLS
GRA1220C.XLS

GRA_1221
GRA1221A.XLS
GRA1221B.XLS
GRA1221C.XLS
GRA1222D.XLS

GRA_1222
GRA1222A.XLS
GRA1222B.XLS
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LAS

LAS_1215
LAS1215.XLS

LAS_1216
LAS1216.XLS

LAS_1217
LAS1217.XLS

LAS_1218
LAS1218.XLS

LAS_1219
LAS1219.XLS

NGR_1220
NGR1220A.XLS

NGR_1222
NGR1222A.XLS
NGR1222B.XLS

PWL

PWL_1215
PWL1215A.XLS
PWL1215B.XLS

PWL_1216
PWL1216A.XLS
PWL1216B.XLS
LAS_1220
LAS1220.XLS

LAS_1221
LAS1221.XLS

LAS_1222
LAS1222.XLS

NGR

NGR_1216
NGR1216A.XLS
NGR1216B.XLS

NGR_1217
NGR1217A.XLS
NGR1217B.XLS
NGR1217C.XLS

PWL_1217
PWL1217A.XLS
PWL1217B.XLS
PWL1217C.XLS

PWL_1220
PWL1220A.XLS
PWL1220B.XLS

PWL_1221
PWL1221A.XLS
PWL1221B.XLS
PWL1221C.XLS

PWL_1222
PWL1222A.XLS
PWL1222B.XLS
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RFL

RFL_1215
RFL1215A.XLS
RFL1215B.XLS

RFL_1216
RFL1216A.XLS
RFL1216B.XLS

RFL_1217
RFL1217A.XLS
RFL1217B.XLS
RFL1217C.XLS

RFL_1218
RFL1218A.XLS

RFL_1222
RFL1222A.XLS
RFL1222B.XLS

SUS

SUS_1215
SUS1215A.XLS
SUS1215B.XLS

SUS_1216
SUS1216A.XLS
SUS1216B.XLS

SUS_1217
SUS1217A.XLS
SUS1217B.XLS
RFL1218B.XLS
RFL1218C.XLS

RFL_1219
RFL1219A.XLS
RFL1219B.XLS

RFL_1220
RFL1220A.XLS
RFL1220B.XLS
RFL1220C.XLS

RFL_1221
RFL1221A.XLS
RFL1221B.XLS
RFL1221C.XLS
RFL1222D.XLS

SUS1217C.XLS

SUS_1218
SUS1218A.XLS
SUS1218B.XLS
SUS1218C.XLS

SUS_1219
SUS1219A.XLS
SUS1219B.XLS

SUS_1220
SUS1220A.XLS
SUS1220B.XLS
SUS1220C.XLS

SUS_1221
SUS1221A.XLS
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SUS1221B.XLS
SUS1221C.XLS
SUS1222D.XLS

SUS_1222
SUS1222A.XLS
SUS1222B.XLS
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 199 Site Map 

ODP Map (Legs 100–199)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A second CD-ROM is included with this volume. The “Log and Core Data” CD contains Leg 199 
depth-shifted and processed downhole logging data and shipboard core logging data (gamma ray 
attenuation bulk density, magnetic susceptibility, natural gamma radiation, P-wave velocity, moisture 
and density, and color reflectance). The downhole logging data are provided by the Borehole Research 
Group at the Lamont-Doherty Earth Observatory (LDEO), Wireline Logging Operator for ODP.

Most of the logging and core data included on this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 

contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory of Columbia 
University, PO Box 1000, 61 Route 9W, Palisades NY 10964, USA; Tel: (845) 365-8341; Fax: (845) 365-
3182; E-mail: borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–173, 174B, 175, and 180. The indexes are 
contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). 
These indexes can be searched individually or collectively.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

199IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR199_01.PDF (Leg 199 Summary)VOLUME
(Leg 199 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(Information about the volume CD-ROM in ASCII format)

MAPS
(Drilling location maps)

ODPMAP.PDF 
(ODP map, Legs 100 through 199)

CHAPTERS
(Volume chapters)

199_MAP.PDF 
(Leg 199 site map)

IR199_02.PDF (Explanatory Notes)

IR199_03.PDF (Global Coupled Climate Model)

IR199_04.PDF (Seismic Stratigraphy for the 
Paleogene Sedimentary Section)

IR199_05.PDF (Determination of Equatorial 
Pacific Mineralogy)

IR199_06.PDF (Determination of Biogenic Opal)

DSDPMAP.PDF 
(DSDP map, Legs 1 through 96)

COR_1215.PDF (Site 1215)CORES
(Visual core descriptions, smear
slide data tables, and digital 
core images)

COR_1216.PDF (Site 1216)

COR_1217.PDF (Site 1217)

IMAGES (PDF files of core images)

IR199_07.PDF (Geochemical Analysis of Bulk 
Marine Sediment)

IR199_08.PDF (Site 1215)

COR_1218.PDF (Site 1218)

COR_1221.PDF (Site 1221)

COR_1222.PDF (Site 1222)

MAC

UNIX

WINDOWS

IR199_09.PDF (Site 1216)

IR199_10.PDF (Site 1217)

IR199_11.PDF (Site 1218)

IR199_12.PDF (Site 1219)

IR199_13.PDF (Site 1220)

IR199_14.PDF (Site 1221)

IR199_15.PDF (Site 1222)

COR_1219.PDF (Site 1219)

COR_1220.PDF (Site 1220)

(Continued on next page)

TABLES
(Data tables in ASCII format of 
smear slide data and selected 
biostratigraphy, paleomagnetism, 
geochemistry, and physical properties 
data.)

IR199_01 (Leg 199 Summary file)

IR199_02 (Explanatory Notes files)

IR199_08 (Site 1215 files)

IR199_09 (Site 1216 files)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

SUPP_MAT
(Supplementary Material)

GRA
(Gamma ray attenuation [GRA] files in 
Microsoft Excel)

GRA_1215 (Site 1215 files)

GRA_1216 (Site 1216 files)

NGR
(Natural gamma ray [NGR] data files 
in Microsoft Excel)

NGR_1216 (Site 1216 files)

NGR_1217 (Site 1217 files)

VOLUME
(Continued)

INDEX.PDX 
(Acrobat file used to enable Acrobat Search of the
199 Initial Reports)

TABLES
(Continued)

IR199_15 (Site 1222 files)

S_SLIDES (Sites 1215 through 1222)

README.TXT

IR199_13 (Site 1220 files)

IR199_14 (Site 1221 files)

IR199_12 (Site 1219 files)

GRA_1217 (Site 1217 files)

GRA_1218 (Site 1218 files)

GRA_1219 (Site 1219 files)

GRA_1220 (Site 1220 files)

GRA_1221 (Site 1221 files)

GRA_1222 (Site 1222 files)

NGR_1220 (Site 1220 file)

NGR_1222 (Site 1222 files)

CRSM
(Expanded coring summary tables
[CRSM] in ASCII)

1215CRSM.TXT

1216CRSM.TXT

1217CRSM.TXT

1218CRSM.TXT

1219CRSM.TXT

1220CRSM.TXT

1221CRSM.TXT

1222CRSM.TXT

LAS
(Light absorption spectroscopy [LAS]
files in Microsoft Excel)

LAS_1215 (Site 1215 file)

LAS_1216 (Site 1216 file)

LAS_1217 (Site 1217 file)

LAS_1218 (Site 1218 file)

LAS_1219 (Site 1219 file)

LAS_1220 (Site 1220 file)

LAS_1221 (Site 1221 file)

LAS_1222 (Site 1222 file)

(Continued on next page)

IR199_10 (Site 1217 files)

IR199_11 (Site 1218 files)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 173NDX.PDF,
174BNDX.PDF, 175NDX.PDF, and 180NDX.PDF 
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

SUPP_MAT
(Continued)

RFL_1218 (Site 1218 files)

RFL_1219 (Site 1219 files)

RFL_1220 (Site 1220 files)

RFL_1221 (Site 1221 files)

RFL_1222 (Site 1222 files)

SUS
(Magnetic susceptibility [SUS] files in 
Microsoft Excel)

SUS_1215 (Site 1215 files)

SUS_1216 (Site 1216 files)

SUS_1217 (Site 1217 files)

SUS_1218 (Site 1218 files)

SUS_1219 (Site 1219 files)

SUS_1220 (Site 1220 files)

SUS_1221 (Site 1221 files)

SUS_1222 (Site 1222 files)

README.TXT

PWL
(P-wave log [PWL] data files in 
Microsoft Excel)

PWL_1215 (Site 1215 files)

PWL_1216 (Site 1216 files)

PWL_1217 (Site 1217 files)

PWL_1220 (Site 1220 files)

PWL_1221 (Site 1221 files)

PWL_1222 (Site 1222 files)

RFL
(Color reflectance [RFL] files in 
Microsoft Excel)

RFL_1215 (Site 1215 files)

RFL_1216 (Site 1216 files)

RFL_1217 (Site 1217 files)
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